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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 
Our mission is to:

1. Provide a Superior Customer Experience
• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and 

it's our fault.

6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.) 
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Important Regulatory and Safety Notices to Service Personnel
Before using this product and any associated equipment, read all the Important Safety Instructions listed below so 
as to avoid personal injury and to prevent product damage.

The OverDrive system makes use of a number of individual component products to make up a complete turnkey 
system. The Important Safety Instructions section of this manual is intended to compliment individual OEM 
product manuals and the User must refer to, and heed, any safety instruction outline in these supplementary product 
manuals. Separate manuals are included for the following component products:

• Server PC(s)
• LCD Flat Screen Display(s) & Power Supply

This system may also require specific equipment, and /or installation procedures be carried out to satisfy certain 
other regulatory compliance requirements. Notices have been included in this publication to call attention to these 
specific requirements.



Symbol Meanings

Protective Earth — This symbol identifies a Protective Earth (PE) terminal, which is provided for 
connection of the supply system’s protective earth (green or green/yellow) conductor.

This symbol on the equipment refers you to important operating and maintenance (servicing) instructions 
within the Product Manual Documentation. Failure to heed this information may present a major risk of 
damage or injury to persons or equipment.

Warning — The symbol with the word “Warning” within the equipment manual indicates a potentially 
hazardous situation which, if not avoided, could result in death or serious injury.

Caution — The symbol with the word “Caution” within the equipment manual indicates a potentially 
hazardous situation which, if not avoided, may result in minor or moderate injury. It may also be used to 
alert against unsafe practices.

Warning Hazardous Voltages — This symbol is intended to alert the user to the presence of 
uninsulated “dangerous voltage” within the product enclosure that may be of sufficient magnitude to 
constitute a risk of shock to persons.

ESD Susceptibility — This symbol is used to alert the user that an electrical or electronic device or 
assembly is susceptible to damage from an ESD event.



Important Safety Instructions
• Read these instructions. 
• Keep these instructions.
• Heed all warning.
• Follow all instructions.

Warning The safe operation of this product requires that a protective earth connection be provided. 
A grounding conductor in the equipment's supply cord provides this protective earth. To 
reduce the risk of electrical shock to the operator and service personnel, this ground 
conductor must be connected to an earthed ground.
Use only power cords specified for this product and certified for the country of use. Refer 
to the Product Power Cord Requirement Section that follows. 
Do not defeat safety purpose of the grounding-type plug. A grounding type plug has two 
blades and a third grounding prong. The third prong is provided for your safety. If the 
provided plug does not fit in to your outlet, consult an electrician for replacement of the 
obsolete outlet.
Protect the power cord from being walked on or pinching particularly at plugs, 
convenience receptacles, and point where they exit from the apparatus.

Warning Indoor Use: “WARNING – TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, 
DO NOT EXPOSE THIS APPARATUS TO RAIN OR MOISTURE”
Do not use this apparatus near water.
Do not block any ventilation openings. Install in accordance with manufacturer’s 
instructions. 
Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus 
(including amplifiers) that produce heat.
Only use attachments/accessories specified by the manufacturer.
Unplug this apparatus during lightning storms or when unused for long periods of time.
Clean only with a dry cloth.

Warning Refer all servicing to qualified personnel. Servicing is required when the apparatus has 
been damaged in any way, such as power-supply cord or plug damage, liquid has been 
spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or 
moisture, does not operate normally, or has been dropped.

Caution  To reduce the risk of fire, replacement fuses must be the same type and rating.

Warning This product contains safety critical parts, which if incorrectly replaced may present a risk 
of fire or electrical shock. Components contained within the product’s power supplies and 
power supply area, are not intended to be customer serviced and should be returned to the 
factory for repair



Product Power Cord Requirements

EMC Notices
US FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a Commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense.

CANADA

This Class “A” digital apparatus complies with Canadian ICES-003. 

Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

EUROPE

This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 
93/68/EEC.

INTERNATIONAL

This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002 and found to 
comply with the limits for a Class A Digital device.

Warning North American Line Voltages 100 - 120 Volt 
This product is supplied with certified 10A/125V SVT type supply cords. 
Conductors are color coded white (neutral), black (line) and green or green/yellow 
(ground). 
Operation of this equipment at line voltages exceeding 130V requires that alternative 
supply cords with appropriate voltage and current ratings be used.

Warning International Line Voltages 200 - 240 Volt 
This product has been designed for use with certified IEC 320- C13 10A/250V - H03 
VV-F3G 1.00mm2 type line cord. 
International product orders are supplied with a certified 10A/250V line cords, utilizing a 
molded 3-pin IEC 320-C13 type connector at one end and stripped conductors on the 
other. One line cord is provided. Conductors are CEE color coded; blue (neutral), brown 
(line), and green/yellow (ground). 
Installation by a qualified Electrician, of an appropriately approved A/C wall plug 
certified for the country of use, is required.
Alternatively, other IEC 320 C-13 type power cords may be used, provided that they meet 
the necessary safety certification requirements for the country in which they are to be 
used. Refer to the correctly specified line cord above.

Notice Changes or modifications to this equipment not expressly approved by Ross Video Ltd. could 
void the user’s authority to operate this equipment.

Notice This is a Class A product. In domestic environments, this product may cause radio interference, 
in which case the user may have to take adequate measures.



Warranty and Repair Policy
The OverDrive Live and OverDrive News systems are backed by a comprehensive one-year warranty on all 
components.

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as 
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the 
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, 
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo 
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or 
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, 
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard 
warranty period by one year increments. For more information about an extended warranty for your OverDrive 
system, contact your regional sales manager.

Environmental Information
The equipment that you purchased required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction 
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health 
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited 
could void the user’s authority to operate this equipment.



Use of Hazardous Substances in Electrical and Electronic Products (China RoHS)

Ross Video Limited has reviewed all components and processes for compliance to:

“Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic 
Products” also known as China RoHS.

The “Environmentally Friendly Use Period” (EFUP) and Hazardous Substance Tables have been established for all 
products. We are currently updating all of our Product Manuals.

The Hazardous substances tables are available on our website at:

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

电器电子产品中有害物质的使用 

Ross Video Limited 按照以下的标准对所有组件和流程进行了审查： 

“电器电子产品有害物质限制使用管理办法”也被称为中国RoHS。 

所有产品都具有“环保使用期限”(EFUP）和有害物质表。目前，我们正在更新我们所有的产品手册。 

有害物质表在我们的网站： 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613 • 652 • 4886
Fax: (+1) 613 • 652 • 4425

Technical Support: (+1) 613 • 652 • 4886
After Hours Emergency: (+1) 613 • 349 • 0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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Introduction
Thank you, and congratulations on choosing the CX Panel to control your devices. CX Panels offer control panels 
for those who prefer a dedicated control surface.

About This Guide
This guide covers the configuration of your CX Panel. The following chapters are included:

1. “Introduction” provides a summary of important terms, conventions, and features.

2. “CX Panel Models” provides an overview of the available CX Panel models.

3. “Connection to the Network” provides procedures for connect a CX Panel to your local network.

4. “Connecting DashBoard™ to a CX Panel” provides procedures for configuring a CX Panel through 
DashBoard.

5. “Calibrating Controls” provides procedures for calibrating CX Panel controls.

6. “Updating a CX Panel” provides procedures for updating CX Panel operating system or applications.

7. “CX Director Panel OverDrive Setup” provides procedures for setting up a CX Director Panel for 
OverDrive.

8. “CX-3R Joystick Panel Setup” provides procedures for setting up a CX-3R Joystick Panel.

If, at any time, you have a question pertaining to the installation or operation of your CX Panel, please contact us at 
the numbers listed in the section “Contacting Technical Support” on page 2–2. Our technical staff are always 
available for consultation, training or service.

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the RundownControl section, click Install License.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

1. In the Open box, enter the following application name:

services.msc 

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

• using RapidRestore to archive and backup OverDrive rundowns and settings, refer to the chapter 
“RapidRestore™” on page 16–1 in the OverDrive User Guide.
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Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Exit,” you would click the File menu and then click Exit.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 After installing Caprica Server software, licenses must be obtained from Ross Video Technical Support before 
using the Caprica Server.

Getting Help
The OverDrive Online Help system can be accessed from any of the components of OverDrive. Online Help opens 
in a Microsoft Internet Explorer® window.

The OverDrive Online Help system displays, by default, the Contents pane. To access the Search or Glossary 
panes, click the Search or Glossary button on the top toolbar in the Online Help system.

Contacting Technical Support
Technical Support is staffed by a team of experienced specialists ready to assist you with any question or technical 
issue.

Ross Video has technical support specialists strategically located around the globe to ensure a prompt response to 
technical inquiries. Our primary technical support center is located in Ottawa, Ontario, Canada. In addition, we 
have offices in The United Kingdom (London), Australia (Sydney), and Singapore with satellite locations in New 
York City, The Netherlands, and China. As we expand our presence globally, we are constantly evaluating other key 
locations to have a local technical support specialist in order to better service our customers.

North America
Our North America center located in Ottawa, Ontario, Canada and is open Monday to Friday 8:30 a.m. to 6:00 p.m. 
EST, with 24/7/365 on-call service after hours.

Our telephone number is: +1-613-686-1557

Toll free within North America: +1 833-859-0499

EMEA
Our EMEA center is open Monday to Friday 8:30 a.m. to 5:00 p.m. GMT. After hours support is provided by our 
North America location.

International toll free: +800 3540 3545

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Australia
Our Sydney, Australia office is located in Alexandria, NSW.

Our local support telephone number is: 1300 007 677

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.
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Online
E-mail: techsupport@rossvideo.com 

Website: open a support request using the link https://support.rossvideo.com/ to open a support request.

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
https://support.rossvideo.com/
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CX Panel Models
The CX Panel is available in the following models to fit your requirements to control devices connected to Ross 
Video systems:

• Director — this model has control buttons and audio faders for Ross Video OverDrive control.
• Everything — this model has control buttons, audio faders, a joystick, and rollers for Ross Video OverDrive 

control.
• CX-3R Joystick — this model has joysticks and buttons that can be used with Ross Video SmartShell to control 

robotic cameras.

The following topics are discussed in this chapter:

• CX Director Panel
• CX Everything Panel
• CX-3R Joystick Panel
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CX Director Panel
The CX Director Panel is an optional companion control panel for users who prefer a dedicated control surface to 
run Custom Controls from Caprica and control audio channel faders. A CX Director Panel contains the following 
OverDrive controls:

• Audio Faders — 10 audio channel faders that work in conjunction with DirectControl to control the faders in 
the On-Air Audio view.

• Button Pad — 32 multi-color LCD buttons that enable to access 32 pages that each contain 32 buttons to which 
you can assign a Custom Control. Pressing a CX Director Panel button runs the assigned Custom Control from 
the Caprica Server in your OverDrive system.

Figure 3.1  CX Director Panel

1. Menu Button

Press this button to display the CX Director Panel Main menu in the display to the left of the button. Tap the 
display to select a Main menu function.

2. Main Menu or Channel Mnemonics

A two segment display that displays the CX Director Panel Main menu or the name of the channel controlled by 
the fader directly beneath it. Channel names are retrieved from the Caprica Server.

3. Current Audio Faders

The current audio faders mirror and control the audio levels in the On-Air Audio view of the DirectControl. The 
first ten enabled channels in the On-Air Audio view can be controlled by the CX Director Panel audio faders.

4. Page or Custom Control Buttons

You can configure the 32 multi-color LCD buttons to run a selected Custom Control or run a Custom Control and 
then open a new page of Custom Controls when pressed.

1) Menu Button 2) Main Menu or Channel Mnemonics

3) Current Audio Faders 4) Page or Custom Control Buttons
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Panel Setup
Refer to the following chapters to setup your CX Director Panel:

• “Connection to the Network” on page 4–1
• “Connecting DashBoard™ to a CX Panel” on page 5–1
• “Calibrating Controls” on page 6–1
• “CX Director Panel OverDrive Setup” on page 8–1

CX Everything Panel
The CX Everything Panel is an optional companion control panel for users who prefer a dedicated control surface to 
run Custom Controls from Caprica, control audio channel faders, and control cameras. A CX Everything Panel 
contains the following controls for OverDrive:

• Audio Faders — 10 audio channel faders that work in conjunction with DirectControl to control the faders in 
the On-Air Audio view.

• Left Button Pad — 15 multi-color LCD buttons that enable to access 15 pages that each contain 15 buttons to 
which you can assign a Custom Control. Pressing a CX Director Panel button runs the assigned Custom Control 
from the Caprica Server in your OverDrive system.

• Right Button Pad — 15 multi-color LCD buttons that enable to access 15 pages that each contain 15 buttons to 
which you can assign a Custom Control. Pressing a CX Director Panel button runs the assigned Custom Control 
from the Caprica Server in your OverDrive system.

• Joystick — 
• Roller — 

Figure 3.2  CX Director Panel

1) Menu Button 2) Main Menu or Channel Mnemonics

3) Roller 4) Joystick

5) Current Audio Faders 6) Button Pad 1

7) Button Pad 2
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1. Menu Button

Press this button to display the CX Director Panel Main menu in the display to the left of the button. Tap the 
display to select a Main menu function.

2. Main Menu or Channel Mnemonics

A two segment display that displays the CX Director Panel Main menu or the name of the channel controlled by 
the fader directly beneath it. Channel names are retrieved from the Caprica Server.

3. Roller

When you select a camera, you can use the roller to focus or control the iris.

4. Joystick

When you select a camera, you can use the joystick to control pan, tilt, and zoom.

5. Current Audio Faders

The current audio faders mirror and control the audio levels in the On-Air Audio view of the DirectControl. The 
first ten enabled channels in the On-Air Audio view can be controlled by the CX Director Panel audio faders.

6. Button Pad 1

You can configure the 15 multi-color LCD buttons to run a selected Custom Control or run a Custom Control and 
then open a new page of Custom Controls when pressed.

7. Button Pad 2

You can configure the 15 multi-color LCD buttons to run a selected Custom Control or run a Custom Control and 
then open a new page of Custom Controls when pressed.

Panel Setup
Refer to the following chapters to setup your CX Director Panel:

• “Connection to the Network” on page 4–1
• “Connecting DashBoard™ to a CX Panel” on page 5–1
• “Calibrating Controls” on page 6–1
• “CX Everything Panel OverDrive Setup” on page 9–1
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CX-3R Joystick Panel
The CX-3R Joystick Panel is a control panel used for robotics control. 
A CX-3R Joystick Panel contains 30 multi-color LCD buttons that can be used for camera selection and control. 

Figure 3.3  CX-3R Joystick Panel

1. Joysticks

Controls X and Y movement, lift height of the robotic pedestal, pan, tilt, and zoom.

2. Control Knobs

Adjustments like iris settings in SmartShell to control lens brightness, or the execution time of a preset or 
movement.

3. Display Screens

Used for network setup, panel connectivity status, and knob assignments and display of information during 
operation.

4. Home Knob

Currently used as a button to switch between configuration mode and operation mode.

5. Button Panels

Camera selection, preset and move execution, and other robotic commands (e.g., Cue, Cut, and Run).

6. Rollers

Adjustments like image sharpness, and duration of a move after execution.

Panel Setup
Refer to the following chapters to setup your CX-3R Joystick Panel:

• “Connection to the Network” on page 4–1
• “Connecting DashBoard™ to a CX Panel” on page 5–1
• “Calibrating Controls” on page 6–1
• “CX-3R Joystick Panel Setup” on page 10–1

1) Joysticks 2) Control Knobs

3) Display Screens 4) Home Knob

5) Button Panels 6) Rollers
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Connection to the Network
To control devices, the CX Panel must be connected to your local area network. Connecting to your local area 
network requires that you cable your CX Panel and then set an IP address for it.

The following topics are discussed in this chapter:

• Connecting a CX Panel to the Network
• Ports
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Connecting a CX Panel to the Network
Connecting your CX Panel to your local area network requires that you cable your panel and then set an IP address 
for it.

Cabling a CX Panel
In an OverDrive system for a CX Director Panel, or a SmartShell System for a CX-3R Joystick Panel, a CX Panel 
connects to the system through your local area network. A CX Panel has connectors for a primary (PS1) and a 
secondary (PS2) power supply, and one Ethernet port on the back of the panel.

Note: The connections on both the CX Director Panel and CX-3R Joystick Panel are the same.

Figure 4.1  CX Director Panel Cable Connections

Figure 4.2  CX Everything Panel Cable Connections

Figure 4.3  CX-3R Joystick Panel Cable Connections

To cable a CX Panel

1. Connect and secure one of the supplied 12V DC power supplies to the PWR 1 connector on the back of the CX 
Panel before connecting the power supply to the AC mains power.

 Connecting the power supply to the AC mains power before connecting to the CX Panel could damage the panel.

2. Connect the power supply to the AC mains power.

3. Use an Ethernet cable to connect the CX Panel Ethernet port to your local area network.



CX Panel Hardware Setup Guide Connection to the Network • 4–3

For More Information on...
• installing a CX Panel, refer to the Ross CX Panel Installation Caprica Device Setup Sheet.

Setting the CX Panel IP Address
After you physically connect a CX Panel to your network, you must set the panel IP address to enable it to 
communicate with the OverDrive Server (for the CX Director Panel and CX Everything Panel) or the SmartShell 
Server (for CX-3R Joystick Panel), and to configure the panel using DashBoard software.

 The IP address that you set for your CX Panel should not be used by any other device in your network.

The panel IP address setup is the same on the CX Director Panel, CX Everything Panel, and CX-3R Joystick Panel. 
The IP address is set using the right-most display of each panel. 

Figure 4.4  CX Director Panel Display to Set the IP Address

Figure 4.5  CX Everything Panel Display to Set the IP Address

Figure 4.6  CX-3R Joystick Panel Display to Set the IP Address
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To set the CX Panel IP address

1. Turn on your CX Panel. The CX Panel stays dark for about a minute while it starts up. The right CX Panel 
screen displays the Ross logo when the panel is ready to use.

2. On the right CX Panel screen, tap the Ross logo.

The Network Setting screen displays.

3. In the Network Settings screen, tap the IP Address box.

CX Director Panel IP Address box and keypad buttons activate.

CX Everything Panel IP Address box and keypad buttons activate.

CX Robotics Panel IP Address box and keypad buttons activate.
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4. Use the keypad to enter a static IP address for your CX Panel.

5. Tap the Subnet Mask box.

6. Use the keypad to enter the subnet mask for your CX Panel.

7. Tap the Gateway box.

8. Use the keypad to enter the IP address of the default gateway for your CX Panel.

9. Tap Save.

The CX Panel saves the entered network settings and then displays the Main menu.

Ports
The information provided in the following table lists the default ports used by CX Panels:

Table 4.1  OverDrive Ports

Port Protocol
Can be 

Disabled? Disabled Function
52543 OGP JSON No

80 HTTP n

22 SSH No Service is disabled by default. Can be enabled 
using a configured USB key.
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Connecting DashBoard™ to a CX 
Panel
The Ross Video DashBoard Control System application enables you to connect to and configure your CX Panel 
hardware.

The following topics are discussed in this chapter:

• Installing DashBoard
• Connecting Dashboard to a CX Panel
• Connection Status
• Connecting a CX Panel to a Client
• Collecting System Logs
• Viewing Software Licenses
• Setting Time
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Installing DashBoard
To connect to and configure a CX Panel, you need to use the DashBoard Control System application on a computer 
that has connectivity to the CX Panel. You can download the DashBoard application installer from the Ross Video 
website.

When installing DashBoard for the sole purpose of configuring a CX Panel, complete the following recommended 
component selections on the Choose Components screen of the DashBoard application installer:

• Select the DashBoard Framework box.

Figure 5.1  DashBoard Application Installer

For More Information on...
• DashBoard application installation or uninstall, refer to the DashBoard Control System User Manual and the 

DashBoard Online Help system.
• DashBoard plug-in updates, refer to the DashBoard Control System User Manual and the DashBoard Online 

Help system.
• where to download the Dashboard application installer, refer to the Terminal Equipment | openGear | Control 

& Monitoring | DashBoard section of the Ross Video website.

Connecting Dashboard to a CX Panel
Now that you know the IP address of your CX Panel, you can connect DashBoard with the panel to enable you to 
configure the panel using DashBoard software.

1. On a computer connected to the same subnetwork as your CX Panel, use one of the following methods to 
launch the current version of DashBoard software:

• Double-click the DashBoard icon on the desktop.
• Use the Start menu to select All Programs > DashBoard > DashBoard.

DashBoard opens.

www.rossvideo.com
www.rossvideo.com
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2. Use the File menu to select New > TCP/IP DashBoard Connect or openGear Device.

The TCP/IP DashBoard Connect/openGear Device dialog box opens.

3. In the IP Address box, enter the IP address of the CX Panel.

Your Network Administrator can provide you with the IP address of your CX Panel.

4. Click Detect Frame Information.

DashBoard uses the information it detected from your CX Panel to configure the remaining settings in the 
TCP/IP DashBoard Connect/openGear Device dialog box.

5. Click Finish.

The DashBoard Tree View displays a node for the new CX Panel.

6. Hover the mouse over the CX Panel node to view the following information about the panel:

• IP address of the CX Panel
• Client to CX Panel connection status
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7. In the DashBoard Tree View, expand the new CX Panel node you added to DashBoard.

The CX Panel node displays the CX Panel node, which is used to configure the CX Panel.

8. Double-click the CX Panel (Director or CX-3R Joystick) node.

Configuration settings for the selected CX Panel open in the Device View.

9. Click the Admin tab.

The Admin tab opens and displays the connected CX Panel hardware, software version, and copyright 
information.

10. To refresh the information displayed in the Admin tab, click Refresh at the bottom of the tab.

11. To close the Admin tab, click Close at the bottom of the tab.
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Connection Status
The LED in the lower right corner of a CX Panel node indicates the current connection status between DashBoard 
and the CX Panel. The LED reports the following connection states:

Connecting a CX Panel to a Client
Connecting the CX Panel to a client in your system enables the CX Panel to receive and display information from 
the client. The CX Panel Client Connection tab contains the settings to configure your CX Panel to connect with the 
client in your system. The client to which you connect your CX Panel depends on the panel type as follows:

• CX Director Panel — Caprica Server
• CX Everything Panel — Caprica Server
• CX-3R Joystick Panel — SmartShell

To connect a CX Panel to a client

1. In the DashBoard Tree View, expand your CX Panel node.

2. Double-click the CX Panel (Director or CX-3R Joystick) node.

The Device View opens.

3. Click the Client Connection tab.

The Client Connection tab opens.

Table 5.1  CX Panel Connection Status

LED Status
A connection exists between DashBoard the CX Panel.

DashBoard is trying to establish a connection with the CX Panel, but there 
may be a connectivity problem.

There is no connection between DashBoard the CX Panel. Verify that the 
CX Panel is turned on and running.
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4. In the IP Address box, enter the IP address of the Caprica Server or SmartShell in your system.

5. In the Port box, enter or select the port number used by the CX Panel to communicate with the Client.
Note: For use with SmartShell, the default port is 14011.

6. Click Connect.

The Client Connection Status field displays the connection status between your CX Panel and the Client.

Collecting System Logs
Logs from your CX Panel can be used to trouble shoot panel problems. In DashBoard, the CX Panel Logs tab 
enables you to gather CX Panel logs into a single file that you can download to your computer.

To download CX Panel log files

1. In the DashBoard Tree View, expand your CX Panel node.

2. Double-click the CX Panel (Director or CX-3R Joystick) node.

The Device View opens.

3. Click the Logs tab.

The Logs tab opens.

4. In the Collect Logs section, select one of the following options to set the number of days worth of logs to 
collect for a log file:

• All — collect the logs from all days.
• Number Of Days — collect the logs for a set number of days from the current date. When selecting this 

option, use the box to the right to enter or select the number of days worth of logs to collect.
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5. In the Logging Level section, click the severity level to set for the gathered logs. The available severity levels 
are as follows:

• Emergency — system is unusable.
• Alert — action must be taken immediately.
• Critical — critical conditions.
• Error — error conditions.
• Warning — warning conditions.
• Notice — normal but significant conditions. This is the default severity level.
• Info — informational messages.
• Debug — debug messages.

6. In the Collect Logs section, click Collect Logs.

The CX Panel creates a log file in its storage space for the selected number of days. The new log file is added 
to the lists in the Download Logs and Delete Logs sections.

7. In the Download Logs section, use the list to select the log file to download from the CX Panel to your 
computer.

8. Click Browse.

The Open File dialog box opens.

9. Navigate to the folder where you want to save the selected log file.

10. In the File Name box, enter a file name for the log file.

Because log files are text files, you should append .txt to the log file name.

11. Click Open.

The Open File dialog box closes, and the Download Logs section displays the full pathname selected for the 
log file. If you want to clear the pathname, click the X to the left of the pathname.

12. Click Download.

The selected log file downloads to your computer.

Deleting Log Files From the CX Panel
When you no longer require a log file, you can delete the log file from the CX Panel to save storage space.

To delete a log file from a CX Panel

1. In the DashBoard Tree View, expand the CX Panel node.

2. Double-click the CX Panel node.

The Device View opens.

3. Click the Logs tab.

The Logs tab opens.
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4. In the Delete Logs section, use the list to select the log file to delete from the CX Panel.

5. Click Delete.

The CX Panel deletes the selected log file from its storage space.

Viewing Software Licenses
The CX panel uses software covered by the licenses described in the Licenses tab of the CX panel configuration 
settings.

To view software licenses

1. In the DashBoard Tree View, expand your CX Panel node.

2. Double-click the CX Panel node.

The Device View opens.

3. Click the Licenses tab.

The Licenses tab opens.

Setting Time
The date and time on a CX panel can be manually set by yourself or automatically set by a Network Time Protocol 
(NTP) server.

Manual Time Set
The Manual Time Configuration option enables you to manually set the date and time on your CX panel.

 You cannot set the date on your CX panel to a date before November 16, 2024.

To manually set the date and time on a CX panel

1. In the DashBoard Tree View, expand your CX Panel node.

2. Double-click the CX Panel node.

The Device View opens.
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3. Click the Time tab.

The Time tab opens.The System Time field displays the current date and time on your CX panel.

4. Use the Time Zone list to select the time zone which matches the physical location of the CX panel.

5. For the Time Configuration setting, select the Manual option.

6. In the Manual Time Configuration section, click the Date list.

The Calendar tool opens.

Use the Calendar tool as follows to set the current date and time for the CX Panel:

a. Use the Month list to select the current month.

b. Use the Year list to select the current year.

The Calendar tool displays the days for the selected month and year.

c. Click the current day.

The Calendar tool closes, and the Date list displays the selected date.

d. Use the Hours, Minutes, and Seconds lists to set the current time.

The CX panel clock does not start until you click Apply.

e. Click Apply to set the current date and time for the CX panel and start the CX panel clock.
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Automatic Time Set
The Automatic Time Configuration option enables you to use a Network Time Protocol (NTP) server to 
automatically set the date and time on your CX panel.

To automatically set the date and time for a CX panel

1. In the DashBoard Tree View, expand your CX Panel node.

2. Double-click the CX Panel node.

The Device View opens.

3. Click the Time tab.

The Time tab opens.The System Time field displays the current date and time on your CX panel.

4. Use the Time Zone list to select the time zone which matches the physical location of the CX panel.

5. For the Time Configuration setting, select the Automatic option.

6. In the NTP IP Address box of the Automatic Time Configuration section, enter the IP address of the NTP 
server with which to synchronize the CX panel date and time.

7. Click Connect.

The NTP Connection Status field displays the current synchronization status between the selected NTP server 
and the CX Panel.
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Calibrating Controls
The various CX Panel models contain controls that you can calibrate to your preference.

The following topics are discussed in this chapter:

• Calibrating Fader Ranges
• Setting Button Double Press Time
• Setting Button Debounce Time
• Adjusting Fader Touch Sensitivity
• Resetting Fader Touch Sensitivity Baseline
• Calibrating Joystick and Roller Ranges
• Adjusting Joystick Deadzones
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Calibrating Fader Ranges
The range of motion for the faders on your CX Director or CX Everything Panel is unique. Through calibration, 
DashBoard can record the unique range of motion for each fader on a CX Director or CX Everything Panel.

To calibrate the range of CX Director or CX Everything Panel faders

1. In the DashBoard Tree View, expand your CX Panel node.

2. Double-click the CX Panel node.

The Device View opens.

3. Click the Calibration tab.

The Calibration tab opens, displaying the Calibration Settings section.

CX Director Panel 

CX Everything Panel 

4. In the Calibration Mode setting, select the Enable option.

The Calibration Status field displays Enabled to indicate that the CX Director or CX Everything Panel is 
ready for fader calibration.

5. On your CX Director or CX Everything Panel, firmly press on the first fader to engage touchsense.

6. Move the fader to the top position of the range that you want to use for the fader, and then move the fader to the 
bottom position of the range that you want to use for the fader.

You can position faders a short distance from the top or bottom of the physical fader range to set a dead spot for 
the fader. A dead spot prevents bounce when a fader physically hits the top or bottom of the range and bounces 
back to a non-zero value.

7. Repeat step 5 and step 6 for the remaining faders on the CX Director or CX Everything Panel.

8. In the Calibration Mode setting, select the Disable option.

 The Calibration Status field displays Disabled to indicate that the CX Director Panel fader calibration is 
complete and the panel is ready to use with the newly calibrated fader ranges.

Setting Button Double Press Time
On your CX Everything Panel, you can set the maximum time allowed between two consecutive button presses for 
them to be recognized as a double press instead of two separate single presses.

To set the double press for CX Everything Panel buttons

1. In the DashBoard Tree View, expand your CX Panel node.

2. Double-click the CX Panel node.

The Device View opens.
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3. Click the Calibration tab.

The Calibration tab opens, displaying the Buttons section.

4. The default button double press time is 250 milliseconds, and the recommended time range is 200 to 300 
milliseconds. In the Buttons section, use one of the following methods to set the button double press time:

• Drag the Double Press Time slider along the scale. The box to the right of the scale displays the set double 
press time in milliseconds.

• In the box to the right of the Double Press Time scale, enter or select a button double press time in 
milliseconds.

 Always set the Double Press Time to be at least 150 milliseconds longer than the Debounce Time.

Setting Button Debounce Time
On your CX Director or CX Everything Panel, you can set the delay time applied to filter out false multiple signals 
caused by button mechanics. When a button is pressed or released, its contacts physically bounce for a few 
milliseconds before settling. Without a set debounce time, a single press could be detected as multiple presses.

To set the debounce time for CX Director or CX Everything Panel buttons

1. In the DashBoard Tree View, expand your CX Panel node.

2. Double-click the CX Panel node.

The Device View opens.

3. Click the Calibration tab.

The Calibration tab opens, displaying the Buttons section.

CX Director Panel 

CX Everything Panel 

4. The default button debounce time is 50 milliseconds, and the recommended time range is 25 to 75 
milliseconds. In the Buttons section, use one of the following methods to set the button debounce time:

• Drag the Debounce Time slider along the scale. The box to the right of the scale displays the set debounce 
time in milliseconds.

• In the box to the right of the Debounce Time scale, enter or select a button debounce time in milliseconds.

 For CX Everything Panels, always set the Debounce Time to be at least 150 milliseconds shorter than the 
Double Press Time.
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Adjusting Fader Touch Sensitivity
In most situations, you do not need to adjust the touch sensitivity of the faders on your CX Director or CX 
Everything Panel. The temperature and humidity of your working environment can cause fader touch sensitivity to 
behave in an unexpected way. You can adjust the sensitivity of CX Director or CX Everything Panel faders for your 
environment.

To adjust the touch sensitivity of CX Director or CX Everything Panel faders

1. In the DashBoard Tree View, expand your CX Panel node.

2. Double-click the CX Panel node.

The Device View opens.

3. Click the Calibration tab.

The Calibration tab opens, displaying the Fader Touchsense section.

4. The default sensitivity level is 50, and the recommended sensitivity range is 25 to 75. Higher sensitivity values 
increase fader touch sensitivity and lower values decrease it. In the Fader Touchsense section, use one of the 
following methods to adjust fader sensitivity:

• Drag the Sensitivity slider along the scale. The box to the right of the scale displays the set sensitivity level.
• In the box to the right of the Sensitivity scale, enter or select a sensitivity level.

Resetting Fader Touch Sensitivity Baseline
CX Director and CX Everything Panel faders use the touch sensitivity baseline to detect whether an operator is 
touching a fader. If the CX Director or CX Everything Panel is restarted while the operator is still touching a fader, 
it will not be able to detect fader touches since it would have set the sensitivity baseline improperly. Resetting the 
touch sensitivity baseline with no faders being touched will enable fader touch detection once again.

To reset the touch sensitivity baseline for CX Director or CX Everything Panel faders

1. In the DashBoard Tree View, expand your CX Panel node.

2. Double-click the CX Panel node.

The Device View opens.

3. Click the Calibration tab.

The Calibration tab opens, displaying the Fader Touchsense section.

4. Take your fingers off of any CX Panel faders.

5. In the Reset the touchsense baseline section, click Reset.
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Calibrating Joystick and Roller Ranges
The range of motion for the joysticks and rollers on your CX Everything or CX-3R Joystick Panel is unique. 
Through calibration, DashBoard can record the unique range of motion for each joystick and roller on a CX 
Everything or CX-3R Joystick Panel.

To calibrate the range of CX Everything or CX-3R Joystick Panel joysticks and rollers

1. In the DashBoard Tree View, expand your CX Panel node.

2. Double-click the CX Panel node.

The Device View opens.

3. Click the Calibration tab.

The Calibration tab opens, displaying the Calibration Settings section.

CX Everything Panel 

CX-3R Joystick Panel 

4. In the Calibration Mode setting, select the Enable option.

The Calibration Status field displays Enabled to indicate that the CX Everything or CX-3R Joystick Panel is 
ready for joystick calibration.

5. On your CX Everything or CX-3R Joystick Panel, move the right joystick to the Left until it stops and then 
release the joystick.

6. Move the joystick to the Right until it stops and then release the joystick.

7. Move the joystick to the Top until it stops and then release the joystick.
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8. Move the joystick to the Bottom until it stops and then release the joystick.

9. Twist the top of the joystick to the Left until it stops and then release the joystick.

10. Twist the top of the joystick to the Right until it stops and then release the joystick.

11. Repeat step 5 to step 10 for the left joystick on your CX-3R Joystick Panel.

12. For each roller on your CX Everything or CX-3R Joystick Panel, slowly move the roller through one full 
rotation.

13. In the Calibration Mode setting, select the Disable option.

The Calibration Status field displays Disabled to indicate that the joystick calibration is complete and the 
panel is ready to use with the newly calibrated joystick ranges.

Adjusting Joystick Deadzones
After you calibrate the range of motion for the joysticks on your CX Everything or CX-3R Joystick Panel, you can 
configure the deadzones for each joystick. A deadzone is the distance that a joystick must move from the center 
before it starts to move the robotic camera it controls. 

When joystick axes are reconfigured, the output will reset to 0 for all joysticks until the joystick is moved again. 
If a configuration change occurs while the joystick is held, the operator must move the joystick slightly to resume 
operation.

To configure CX Everything or CX-3R Joystick Panel joystick deadzones

1. In the DashBoard Tree View, expand your CX Panel node.

2. Double-click the CX Panel node.

The Device View opens.
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3. Click the Calibration tab.

The Calibration tab opens. The Joystick Deadzone Configuration section displays for the CX Everything 
Panel, while the Left Joystick Deadzone Configuration and Right Joystick Deadzone Configuration 
sections display for the CX-3R Joystick Panel.

CX Everything Panel 

CX-3R Joystick Panel 

4. In the Joystick Deadzone Configuration or Left Joystick Deadzone Configuration section, use the X 
DeadZone setting to set the distance that the joystick must move left or right from the center before it starts to 
move a robotic camera. This setting stops left and right camera movement when the joystick returns to center. 
Use one of the following methods to set the X DeadZone:

• Drag the X DeadZone slider along the scale. The box to the right of the scale displays the set X DeadZone 
distance.

• In the box to the right of the X DeadZone scale, enter or select an X DeadZone distance.

5. Use the Y DeadZone setting to set the distance that the joystick must move up or down from the center before 
it starts to move a robotic camera. This setting stops up and down camera movement when the joystick returns 
to center. Use one of the following methods to set the Y DeadZone:

• Drag the Y DeadZone slider along the scale. The box to the right of the scale displays the set Y DeadZone 
distance.

• In the box to the right of the Y DeadZone scale, enter or select a Y DeadZone distance.

6. Use the Z DeadZone setting to set the distance that the joystick top must twist left or right from the center 
before it starts to move a robotic camera. This setting stops zoom, focus, or iris changes when the joystick 
returns to center. Use one of the following methods to set the Z DeadZone:

• Drag the Z DeadZone slider along the scale. The box to the right of the scale displays the set Z DeadZone 
distance.

• In the box to the right of the Z DeadZone scale, enter or select a Z DeadZone distance.

7. For the CX-3R Joystick Panel, repeat step 4 to step 6 in the Right Joystick Deadzone Configuration section 
to configure the deadzones for the right joystick on your CX-3R Joystick Panel.
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Updating a CX Panel
When Ross Video releases updates for the CX Panel operating system or applications, you can use DashBoard to 
install the updates on your CX Panel hardware.

The following topics are discussed in this chapter:

• Updating the Operating System or Application
• Rebooting the CX Panel
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Updating the Operating System or Application
When Ross Video releases updates for the CX Panel operating system or applications, you can use DashBoard to 
install the updates on your CX Panel hardware. CX Panel operating system and application updates are released as 
package files and installed using the DashBoard Upload Software Wizard.

When CX Panel operating system and application updates are released together, you must install the operating 
system update before installing the application update.

To update the CX Panel operating system or application

1. Contact Ross Video Technical Support to obtain the most recent CX Panel operating system and application 
package files.

2. On a computer connected to the same subnetwork as your CX Panel, launch the current version of DashBoard 
software.

3. In the DashBoard Tree View, expand your CX Panel node.

4. Double-click the CX Panel (Director or CX-3R Joystick) node.

The Device View opens.

5. Click the Admin tab.

The Admin tab opens.

6. At the bottom of the Admin tab, click Upload.

The Select File Upload screen of the Upload Software Wizard opens.

7. To the right of the File box, click Browse.

The Open dialog box opens.

8. Use the Open dialog box to locate and select the CX Panel operating system (cx_panel_os-X.X.X.bin) or 
application (cx_panel_app-X.X.X.bin) package file you downloaded from Ross Video Technical Support.

9. Click Open.

The Open dialog box closes and the File Summary field in the Select File Upload screen displays information 
about the selected package file.

10. Click Finish.

The Upload Software Wizard installs the selected CX Panel operating system or application update. The 
Panel Version or OS Version field in the Admin tab updates to display the version of the newly installed CX 
Panel operating system or application.
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Rebooting the CX Panel
If your CX Panel requires rebooting, you can reboot the panel from Dashboard or by cycling the panel power.

Dashboard Reboot
In Dashboard, you can reboot a CX Panel from the CX Panel node Admin tab.

To reboot a CX Panel from Dashboard

1. On a computer connected to the same subnetwork as your CX Panel, launch the current version of DashBoard 
software.

2. In the DashBoard Tree View, expand your CX Panel node.

3. Double-click the CX Panel (Director or CX-3R Joystick) node.

The Device View opens.

4. Click the Admin tab.

The Admin tab opens.

5. At the bottom of the Admin tab, click Reboot.

An Alert opens.

6. Click Yes.

 The CX Panel reboots.

Power Cycle Reboot
You can also reboot a CX Panel by cycling the panel power.

To reboot a CX Panel by cycling the panel power

1. Disconnect the CX Panel power supply from the AC mains power.

2. Wait five seconds to let all power drain from the CX Panel.

3. Connect the CX Panel power supply to the AC mains power.

The CX Panel reboots.
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CX Director Panel OverDrive 
Setup
In an OverDrive system that contains a Caprica Server, you can connect a CX Director Panel that contains physical 
control buttons and audio faders. CX Director Panels are optional OverDrive companion control panels for users 
who prefer a dedicated control surface. CX Director Panels work in conjunction with the OverDrive touch screen, 
keyboard, and mouse to offer you multiple interfaces to your OverDrive system.

 CX Director Panels only work with OverDrive systems that contain a Caprica Server.

The following topics are discussed in this chapter:

• Configuring CX Director Panel Buttons
• Selecting the Faders to Control
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Configuring CX Director Panel Buttons
A CX Director Panel contains 32 multi-color LCD buttons that enable to access 32 pages that each contain 32 
buttons to which you can assign a Custom Control. Pressing a CX Director Panel button runs the assigned Custom 
Control from the Caprica Server in your OverDrive system. You can also configure CX Director Panel buttons to 
open another button page after the assigned Custom Control finishes.

Assigning Custom Controls to CX Director Panel Buttons
You can assign a Custom Control to each CX Director Panel button in the accessible 32 button pages. Pressing a CX 
Director Panel button runs the assigned Custom Control from the Caprica Server in your OverDrive system. You 
can also add a page change after the assigned Custom Control finishes.

 Before you can assign Custom Controls to CX Director Panel buttons, you must create the required Custom 
Controls on your Caprica Server. Custom Controls must contain at least one command.

To assign Custom Controls to CX Director Panel buttons

1. In the DashBoard Tree View, expand your Caprica Server node.

2. In the Caprica Server node, expand the Slot 0: Caprica node.

3. Double-click the CX Panel Configuration node.

The CX Panel Configuration client opens in the Device View.

4. Use the Window menu to select Full Screen.

The CX Panel Configuration client expands to full screen view.

5. Click the Director tab.

The Director tab opens. Caprica automatically loads the assigned Custom Controls into the displayed buttons.

6. Use the Button Pad Page list on the CX Director Panel image to select the CX Director Panel button page to 
display in the CX Director Panel image.

7. On the CX Director Panel image, click the CX Director Panel button to assign a Custom Control.

8. Use the Bank list to select the Bank that contains the Custom Control to assign to the selected CX Director 
Panel button.
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9. Use the CC list to select the Custom Control to assign to the selected CX Director Panel button.

10. Use the Page list to select the Page of CX Director Panel buttons to display on the CX Director Panel after the 
Custom Control assigned to the button starts. Select None to continue displaying the current page of CX 
Director Panel buttons.

11. Click Apply.

The selected button updates on the CX Director Panel. The assigned Custom Control is only available for the 
selected CX Director Panel button on the selected page.

Customizing CX Director Panel Button Labels and Background Colors
You can customize the names of CX Director Panel buttons that open pages. For CX Director Panel buttons that run 
Custom Controls, you can customize the button names, name text style, and background color.

Page Buttons

The names of CX Director Panel buttons that open pages are set in the CX Director Panel tab of the CX Director 
Panel Configuration client.

To change the name of a CX Director Panel page button

1. At the bottom of the Device View, click CX Director Panel Configuration.

The CX Panel Configuration client opens in the Device View.

2. Use the Window menu to select Full Screen.

The CX Panel Configuration client expands to full screen view.

3. Click the CX Panel tab.

The CX Director Panel tab opens. 

4. Click Director.

The Director section opens. Caprica automatically loads the assigned Custom Controls into the displayed 
buttons.

5. Use the Button Pad Page list on the CX Director Panel image to select the page button to customize.

The CX Director Panel Configuration client displays the configuration of the selected page.

6. Click ••• to the right of the Button Pad Page list.

The Page Name box displays below the CX Director Panel image.

7. In the Page Name box, enter a new name for the page.

8. Click Apply.

The associated page button on the CX Director Panel displays the new page name.

Custom Control Buttons

The name, name text style, and background color specified for a Custom Control are carried over to the CX 
Director Panel button to which it is assigned.
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To customize a CX Director Panel button assigned to a Custom Control

1. At the bottom of the Device View, click Custom Controls.

The Custom Controls client opens.

2. In the Bank column of the Custom Controls table, click the Custom Control bank that contains the Custom 
Control assigned to the CX Director Panel button to customize.

3. In the CC Name column of the Custom Controls table, click the Custom Control assigned to the CX 
Director Panel button to customize.

The Custom Controls client displays the selected bank and Custom Control name at the top of the client.

4. In the Name box at the top of the Custom Controls client, enter the name to display on the CX Director Panel 
button to which the Custom Control is assigned.

5. At the top of the Custom Controls client, click the Button Preview.

The Select Style dialog box opens.

6. Click a Style button in the top button row of the Select Style dialog box to set the text style for the CX Director 
Panel button assigned to the Custom Control.

The available text styles for CX Director Panel buttons names are as follows:

The Select Style dialog box closes and the Button Preview updates along with the button on the CX Director 
Panel.

Standard Small
Small 
Invert Medium

Medium 
Invert Large

Large 
Invert None
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7. Click the Button Preview.

The Select Style dialog box opens.

8. Click a Color button in the bottom button row of the Select Style dialog box to set the background color for 
CX Director Panel button assigned to the Custom Control.

The available background colors for CX Director Panel buttons are as follows:

The Select Style dialog box closes and the Button Preview updates along with the button on the CX Director 
Panel.

Selecting the Faders to Control
A CX Director Panel contains five or ten physical faders that work in conjunction with the DirectAudio interface of 
DirectControl to control the faders in the On-Air Audio view and on the OverDrive system audio mixer. Since a CX 
Director Panel does not have enough faders to control all audio channels in the On-Air Audio view, you must select 
the channels to control with your CX Director Panel faders.

To control an audio channel with a CX Director Panel fader, the channel must meet the following conditions:

• The channel must be selected in the Audio Channel Includes tab.
• The channel must be displayed in the DirectControl On-Air Audio view.
• The channel must be the first five or ten channels that match the previous conditions. The number of channels 

that you can control depends on the number of physical faders on your CX Director Panel.

On the CX Director Panel, the display above a fader displays the channel name it controls.

 Before you can select CX Director Panel faders to control, your Caprica Server must have a configured audio 
mixer device. For more information on configuring an audio mixer Caprica device, refer to the following:

› The Caprica Device Setup Sheet for your audio mixer.
› The Configuring Devices to Connect to an OverDrive System section in the Caprica User Guide.
› The Configuring Audio section in the Caprica User Guide.

To select the audio channels to control with CX Director Panel faders

1. In the DashBoard Tree View, expand your Caprica Server node.

2. In the Caprica Server node, expand the Slot 0: Caprica node.

3. Double-click the CX Director Panel Configuration node.

The CX Director Panel Configuration client opens in the Device View.

4. Use the Window menu to select Full Screen.

The CX Director Panel Configuration client expands to full screen view.

Standard Green Red Blue Yellow Orange None
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5. Click the Audio Channel Includes tab.

The Audio Channel Includes tab opens.

6. To manage the audio channels available to the CX Director Panel, use the check boxes in the Include channel 
column as follows:

• Control — select the check box to the right of an audio channel that you want to control with a physical 
fader on your CX Director Panel.

• Do Not Control —clear the check box to the right of an audio channel that you do not want to control with 
a physical fader on your CX Director Panel.
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CX Everything Panel OverDrive 
Setup
In an OverDrive system that contains a Caprica Server, you can connect a CX Everything Panel that contains 
physical control buttons and audio faders. CX Everything Panels are optional OverDrive companion control panels 
for users who prefer a dedicated control surface. CX Everything Panels work in conjunction with the OverDrive 
touch screen, keyboard, and mouse to offer you multiple interfaces to your OverDrive system.

 CX Everything Panels only work with OverDrive systems that contain a Caprica Server.

The following topics are discussed in this chapter:

• Configuring CX Everything Panel Buttons
• Selecting the Faders to Control
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Configuring CX Everything Panel Buttons
A CX Everything Panel contains 32 multi-color LCD buttons that enable to access 32 pages that each contain 32 
buttons to which you can assign a Custom Control. Pressing a CX Everything Panel button runs the assigned 
Custom Control from the Caprica Server in your OverDrive system. You can also configure CX Everything Panel 
buttons to open another button page after the assigned Custom Control finishes.

A CX Everything Panel contains two pads of 15 multi-color LCD buttons that you can configure to run any 
combination for the following actions when a user presses a button:

• Open a new page of buttons for button pad 1, 2, or both.
• Run a Custom Control.
• Select a camera to control.

Assigning Page Changes to CX Everything Panel Buttons
You can assign a page change to any of the 30 multi-color LCD buttons on your CX Everything Panel. Pressing a 
page change button opens a new page of buttons for button pad 1, 2, or both.

To assign page changes to CX Everything Panel buttons

1. In the DashBoard Tree View, expand your Caprica Server node.

2. In the Caprica Server node, expand the Slot 0: Caprica node.

3. Double-click the CX Panel Configuration node.

The CX Panel Configuration client opens in the Device View.

4. Use the Window menu to select Full Screen.

The CX Panel Configuration client expands to full screen view.

5. Click the Everything tab.

The Everything tab opens.

6. Use the TYPE list to select Standard.

The Standard button actions display below the CX Everything Panel image.
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7. Use the Left Button Pad Page list or the Right Button Pad Page list in the CX Everything Panel image to 
select the button page that contains the button or buttons to assign a page change.

The CX Everything Panel image displays the buttons for the selected page.

8. In the CX Everything Panel image, click the button to assign a page change.

9. Use any combination for the following lists to select the page to open in a button pad:

• Left Page — use this list to select page to open for button pad 1.
• Right Page — use this list to select page to open for button pad 2.

Select None to keep the current page open in the associated button pad.

10. Click Apply.

The selected button updates on the CX Everything Panel. The assigned page change is only available for the 
selected button in the selected page.

Assigning Custom Controls to CX Everything Panel Buttons
You can assign a Custom Control to any of the 30 multi-color LCD buttons on your CX Everything Panel. Pressing 
a CX Everything Panel button runs the assigned Custom Control from the Caprica Server in your OverDrive 
system. You can also add a page change after the assigned Custom Control finishes.

 Before you can assign Custom Controls to CX Everything Panel buttons, you must create the required Custom 
Controls on your Caprica Server. Custom Controls must contain at least one command.

To assign Custom Controls to CX Everything Panel buttons

1. In the DashBoard Tree View, expand your Caprica Server node.

2. In the Caprica Server node, expand the Slot 0: Caprica node.

3. Double-click the CX Panel Configuration node.

The CX Panel Configuration client opens in the Device View.

4. Use the Window menu to select Full Screen.

The CX Panel Configuration client expands to full screen view.

5. Click the Everything tab.

The Everything tab opens.
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6. Use the TYPE list to select Standard.

The Standard button actions display below the CX Everything Panel image.

7. Use the Left Button Pad Page list or the Right Button Pad Page list in the CX Everything Panel image to 
select the button page that contains the button or buttons to assign a Custom Control.

The CX Everything Panel image displays the buttons for the selected page.

8. In the CX Everything Panel image, click the button to assign a Custom Control.

9. Use the Bank list to select the bank that contains the Custom Control to assign to the selected button.

10. Use the CC list to select the Custom Control to assign to the selected button.

11. Use the Page list to select the page of CX Everything Panel buttons to display on the CX Everything Panel 
after the Custom Control assigned to the button starts. Select None to continue displaying the current page of 
CX Everything Panel buttons

12. Click Apply.

The selected button updates on the CX Everything Panel. The assigned Custom Control is only available for 
the selected button in the selected page.

Assigning Cameras to CX Everything Panel Buttons
You can assign a camera to any of the 30 multi-color LCD buttons on your CX Everything Panel. Pressing a CX 
Everything Panel button selects the assigned camera so the you can control it using the CX Everything Panel roller 
and joystick.

 Before you can assign cameras to CX Everything Panel buttons, you must have cameras configured on your 
Caprica Server.

To assign cameras to CX Everything Panel buttons

1. In the DashBoard Tree View, expand your Caprica Server node.

2. In the Caprica Server node, expand the Slot 0: Caprica node.

3. Double-click the CX Panel Configuration node.

The CX Panel Configuration client opens in the Device View.
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4. Use the Window menu to select Full Screen.

The CX Panel Configuration client expands to full screen view.

5. Click the Everything tab.

The Everything tab opens.

6. Use the TYPE list to select Standard.

The Standard button actions display below the CX Everything Panel image.

7. Use the Left Button Pad Page list or the Right Button Pad Page list in the CX Everything Panel image to 
select the button page that contains the button or buttons to assign a camera.

The CX Everything Panel image displays the buttons for the selected page.

8. In the CX Everything Panel image, click the button to assign a camera.

9. Use the Camera list to select the camera to control.

10. Use the Mode list to select the control mode to use for the selected camera. The modes available in the Mode 
list depend on the camera selected in the Camera list.

11. Use the Show list to select the camera show that contains the shots to use with the selected camera. The shows 
available in the Show list depend on the camera selected in the Camera list.

12. Use the Shot list to select the shot to position the selected camera. The presets and moves available in the Shot 
list depend on the show selected in the Show list.

• Shot — move the camera to the preset position when the user presses the associated CX Everything Panel 
button.

• Move — load the camera position, but do not move the camera when the user presses the associated CX 
Everything Panel button. Press the button once again to move the camera to the loaded position.

13. In the Duration box, enter or select the number of seconds in which to move the selected camera to the 
position of the show selected Shot list.
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14. Optionally, you can add a Custom Control and or a page change to your camera selection.

15. Click Apply.

The selected button updates on the CX Everything Panel. The assigned camera is only available for the selected 
button in the selected page.

button CC > Cam> shot

Assigning the Camera to Follow Selection to CX Everything Panel Buttons
You can assign the camera to follow selection to any of the 30 multi-color LCD buttons on your CX Everything 
Panel. CX Everything Panel buttons can be assigned to select the Prepared, On Air, or Next camera.

To assign the camera to follow selection to CX Everything Panel buttons

1. In the DashBoard Tree View, expand your Caprica Server node.

2. In the Caprica Server node, expand the Slot 0: Caprica node.

3. Double-click the CX Panel Configuration node.

The CX Panel Configuration client opens in the Device View.

4. Use the Window menu to select Full Screen.

The CX Panel Configuration client expands to full screen view.

5. Click the Everything tab.

The Everything tab opens.

6. Use the TYPE list to select Follows.

The Follows button actions display below the CX Everything Panel image.

7. Use the Left Button Pad Page list or the Right Button Pad Page list in the CX Everything Panel image to 
select the button page that contains the button or buttons to assign a camera.

The CX Everything Panel image displays the buttons for the selected page.

8. In the CX Everything Panel image, click the button to assign a camera follow selection.
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9. Use the Follows Type list to select the camera to follow:

• Prepared — select the prepared camera. A camera must be selected before you can use this button. The top 
left corner of the information screen displays the text Cam when the CX Everything Panel has selected a 
camera.
Double press the Prepared button to lock and follow the on-air camera. When locked to the on-air camera, 
double press the Prepared button to release the lock.

• On Air — select the first on-air camera. A camera must be selected before you can use this button. The top 
left corner of the information screen displays the text Cam when the CX Everything Panel has selected a 
camera.
Double press the On Air button to lock and follow the on-air camera. When locked to the on-air camera, 
double press the On Air button to release the lock.

• Next — press this button to select the next camera in the camera list. A camera must be selected before you 
can use this button. The top left corner of the information screen displays the text Cam when the CX 
Everything Panel has selected a camera.
When locked to the On-Air camera, the Next button selects the next on-air camera. When locked to the 
Preset camera, the Next button selects the next prepared camera.

10. Click Apply.

The selected button updates on the CX Everything Panel.

Customizing CX Everything Panel Button Appearance
You can customize the names of CX Everything Panel buttons that open pages. For CX Everything Panel buttons 
that run Custom Controls or select cameras, you can customize the button names, name text style, and background 
color.

Page Buttons
Renaming a CX Everything Panel page also changes the name displayed on the CX Everything Panel button 
assigned to open the page.

To rename a CX Everything Panel page and the button assigned to open it

1. At the bottom of the Device View, click CX Panel Configuration.

The CX Panel Configuration client opens in the Device View.

2. Click the Everything tab.

The Everything tab opens.

3. Use the Left Button Pad Page list or the Right Button Pad Page list in the CX Everything Panel image to 
select the page to rename.

4. Click ... to the right of the Button Pad Page list.

The Page Name box displays below the CX Everything Panel image.

5. In the Page Name box, enter a new name for the page.

6. Click Apply.

The name of the selected page updates, and the CX Everything Panel button assigned to open the page displays 
the new page name.

Custom Control and Camera Buttons
Customized CX Everything Panel Custom Control and camera buttons can be quickly changed back to their default 
appearance.
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To customize a CX Everything Panel Custom Control or camera buttons

1. In the DashBoard Tree View, expand your Caprica Server node.

2. In the Caprica Server node, expand the Slot 0: Caprica node.

3. Double-click the CX Panel Configuration node.

The CX Panel Configuration client opens in the Device View.

4. Use the Window menu to select Full Screen.

The CX Panel Configuration client expands to full screen view.

5. Use the Left Button Pad Page list or the Right Button Pad Page list in the CX Everything Panel image to 
select the button page that contains the button or buttons to assign a camera.

The CX Everything Panel image displays the buttons for the selected page.

6. In the CX Everything Panel image, click the button to customize.

The section below the TYPE list displays the current style of the selected button.

7. In the Name box, enter the name to display on the selected CX Everything Panel button.

8. To change the name text style of the selected CX Everything Panel button, complete the following steps:

a. Click the Button Preview.

The Select Style dialog box opens.

b. Click a Style button in the top button row of the Select Style dialog box to set the text style for the CX 
Everything Panel button assigned to the Custom Control.

The available text styles for CX Everything Panel buttons names are as follows:

The Select Style dialog box closes and the Button Preview updates.

c. Click Apply.

The selected button on the CX Everything Panel displays the newly set style.

Standard Small
Small 
Invert Medium

Medium 
Invert Large

Large 
Invert None
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9. To change the background color of the selected CX Everything Panel button, complete the following steps:

a. Click the Button Preview.

The Select Style dialog box opens.

b. Click a Color button in the bottom button row of the Select Style dialog box to set the background color for 
CX Everything Panel button assigned to the Custom Control.

The available background colors for CX Director Panel buttons are as follows:

The Select Style dialog box closes and the Button Preview updates.

c. Click Apply.

The selected button on the CX Everything Panel displays the newly set style.

Restoring Default Appearance for a Button
Customized CX Everything Panel Custom Control and camera buttons can be quickly changed back to their default 
appearance.

To customize a CX Everything Panel Custom Control or camera buttons

1. In the DashBoard Tree View, expand your Caprica Server node.

2. In the Caprica Server node, expand the Slot 0: Caprica node.

3. Double-click the CX Panel Configuration node.

The CX Panel Configuration client opens in the Device View.

4. Use the Window menu to select Full Screen.

The CX Panel Configuration client expands to full screen view.

5. Use the Left Button Pad Page list or the Right Button Pad Page list in the CX Everything Panel image to 
select the button page that contains the button or buttons to assign a camera.

The CX Everything Panel image displays the buttons for the selected page.

6. In the CX Everything Panel image, click the button to customize.

The section below the TYPE list displays the current style of the selected button.

7. Select the Default check box.

8. Click Apply.

The selected button on the CX Everything Panel displays the default style. The default style for Custom Control 
buttons is the name, name text style, and background color specified for Custom Control assigned to the button.

Selecting the Faders to Control
A CX Everything Panel contains five or ten physical faders that work in conjunction with the DirectAudio interface 
of DirectControl to control the faders in the On-Air Audio view and on the OverDrive system audio mixer. Since a 
CX Everything Panel does not have enough faders to control all audio channels in the On-Air Audio view, you must 
select the channels to control with your CX Everything Panel faders.

Standard Green Red Blue Yellow Orange None
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To control an audio channel with a CX Everything Panel fader, the channel must meet the following conditions:

• The channel must be selected in the Audio Channel Includes tab.
• The channel must be displayed in the DirectControl On-Air Audio view.
• The channel must be the first five or ten channels that match the previous conditions. The number of channels 

that you can control depends on the number of physical faders on your CX Everything Panel.

On the CX Everything Panel, the display above a fader displays the channel name it controls.

 Before you can select CX Everything Panel faders to control, your Caprica Server must have a configured audio 
mixer device. For more information on configuring an audio mixer Caprica device, refer to the following:

› The Caprica Device Setup Sheet for your audio mixer.
› The Configuring Devices to Connect to an OverDrive System section on page 26–2.
› The Configuring Audio on page 26–13.

To select the audio channels to control with CX Everything Panel faders

1. In the DashBoard Tree View, expand your Caprica Server node.

2. In the Caprica Server node, expand the Slot 0: Caprica node.

3. Double-click the CX Panel Configuration node.

The CX Panel Configuration client opens in the Device View.

4. Use the Window menu to select Full Screen.

The CX Panel Configuration client expands to full screen view.

5. Click the Audio Channel Includes tab.

The Audio Channel Includes tab opens.

6. To manage the audio channels available to the CX Everything Panel, use the check boxes in the Include 
channel column as follows:

• Control — select the check box to the right of an audio channel that you want to control with a physical 
fader on your CX Everything Panel.

• Do Not Control —clear the check box to the right of an audio channel that you do not want to control with 
a physical fader on your CX Everything Panel.
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CX-3R Joystick Panel Setup
The CX-3R Joystick Panel is a control panel designed for robotic camera systems. It provides precise joystick 
control for camera movement and integrates with SmartShell, Ross Video’s unified control system for robotics. The 
CX Panel Adapter Windows Service is required for communication between the CX-3R Joystick Panel and 
SmartShell.

 CX-3R Joystick Panel only work with SmartShell.

The following topics are discussed in this chapter:

• Install SmartShell CX Panel Adapter Service
• Ensure that SmartShell is configured to use a CX Panel
• Troubleshooting & More Details
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Install SmartShell CX Panel Adapter Service
The CX Panel Adapter Windows Service is required for communication between SmartShell and the CX-3R 
Joystick Panel.

 The SmartShell CX Panel Adapter Service must be installed on the SmartShell machine.

Installing SmartShell CX Panel Adapter Service on your SmartShell Computer
To install SmartShell CX Panel Adapter Service

1. Download the SmartShell CX Panel Adapter Windows Service: 
SmartShellCxPanelAdapter-x.x.x-yyyy.mm.dd-hh.mm.msi

2. Open the Ross SmartShell CX Panel Adapter Setup installer on the SmartShell workstation.

The Ross SmartShell CX Panel Adapter Setup wizard opens.

3. Click Next.

The End-User License Agreement screen opens.

4. Read the End-User License Agreement.

5. Select the I accept the terms of the License Agreement option.
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6. Click Next.

The Choose Setup Type screen opens.

7. Click the Ross SmartShell CX Panel Adapter icon.

The Ready to Install screen opens.

.

8. Click Install.

After the Ross SmartShell CX Panel Adapter installation completes, the Installation Complete screen 
opens.

.
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9. Click Finish.

10. Verify the installation

• Configuration files — C:\Program Files\Ross Video\SmartShellCxPanelAdapter\configuration
• Log files — C:\Program Files\Ross Video\SmartShellCxPanelAdapter\workspace\.metadata\logs 

No configuration changes are needed unless using non-default ports.

Connecting your panel to the CX Panel Adapter Service
Before configuring SmartShell, ensure that the CX Robotics Panel is connected to DashBoard™. 
Refer to “Connecting DashBoard™ to a CX Panel” on page 5–1 for instructions.

Ensure the following:

• The adapter service must be installed and running on the SmartShell computer.
• When connecting in DashBoard™, enter port 14011 and use the IP address of the SmartShell computer (not the 

CX Panel).

Once the DashBoard™ connection is complete, proceed with configuring SmartShell.

Ensure that SmartShell is configured to use a CX Panel
Once the CX-3R Joystick Panel is connected, you must configure SmartShell to communicate with it.

To configure SmartShell for the CX-3R Joystick Panel

1. Ensure that SmartShell version 7.3 or later is installed.

2. Navigate to the SmartShell installation directory:

• Default location: C:\Ross\SmartShell 7.3.xxx.yyy\
• If SmartShell is installed in a different location, navigate to that directory.

3. Open the SmartShell.exe.config configuration file.

4. Remove commented-out lines (<!-- and --> ) related to CX Panel communication:
<!--

<CxPanelAdapter Host="localhost" Port="14010" ConnectInterval="10000"/>
-->

The output to enable this setting should look like the following:
<CxPanelAdapter Host="localhost" Port="14010" ConnectInterval="10000"/>
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5. Save the file and restart SmartShell
Note: The Joystick status indicator in SmartShell changes color based on the connection status:

• Green — Successfully connected to a CX Panel through the Adapter and SmartShell has active control.
• Grey — No connection to the CX Panel Adapter, Ross SmartShell CX Panel Adapter Service or SmartShell 

has not been given active control of the CX Panel. This can occur in the following cases:
› SmartShell is not connected to the SmartShell CX Panel Adapter Service - Confirm that the SmartShell 

CX Panel Adapter Service is running and that SmartShell is properly configured to use a CX Panel, 
including the correct port.

› Multiple SmartShell stations are connected to the same CX Panel Adapter Service - Only one SmartShell 
instance can actively control the panel. The first connected station will show a green status, while 
additional stations will show a gray status with the notification:
Another station <station name> already has control of the CX Panel.

• Red — Connected to the Adapter, but no CX Panel is detected. To resolve this:
› Confirm that the CX Panel Client Connection is correctly configured with the IP address and port of the 

SmartShell CX Panel Adapter Service.
› Ensure that there is no firewall blocking access between the CX Panel and the Adapter Service.

Calibrate the Joysticks
Refer to Calibrating Joystick and Roller Ranges in Calibrating Controls.

Test the Joysticks
After calibrating the joysticks, test them to verify their movements.

To test the CX-3R Joystick Panel

1. Move the joysticks to confirm that SmartShell registers all movements.

If everything has been correctly installed:

• The SmartShell joystick dot will be Green to indicate that a panel is connected 
• The panel will light up to show the set of cameras currently in use by SmartShell 

2. Test a preset move and verify that the panel sends commands to SmartShell.

Troubleshooting & More Details
For additional support on configuring and using the CX-3R Joystick Panel, refer to the CX-3R Joystick Panel User 
Guide (5000DR-380-01).
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